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Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these
application examples and other Siemens publications — e.g. Catalogs - the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Security  Siemens provides products and solutions with industrial security functions that

ipforma- support the secure operation of plants, solutions, machines, equipment and/or

tion networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.

For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept. Third-party
products that may be in use should also be considered. For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit
http://support.industry.siemens.com.
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1 Task

2.1 Solution overview

1 Task

Introduction

This application demonstrates how to deal with the Modbus RTU protocol in the
automation environment of an S7-300 station. It demonstrates the programming of
a Modbus master via CP 341 as well as the programming of a Modbus slave via
ET 200S 1Sl in an S7-300 CPU.

Overview of the automation task

The figure below provides an overview of the automation task.
Figure 1-1

S7-300 -
Automation system Distributed 1/0

-8

The application is to demonstrate the following:
e Configuration of the CP 341 and ET 200S 1Sl for Modbus RTU.
e Creation of a flexible Modbus master/slave program in the S7-300.

Description of the automation task

Entry-ID: 109474714, V 1.0, 04/2013 4
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2 Solution

2
2.1

2.1 Solution overview

Solution

Solution overview

Objective of the application

Display

This application demonstrates the following:
e Basics of the Modbus RTU protocol

e Parameterization of a serial communication processor (CP 341, ET 200S 1SlI)
for communication with Modbus RTU

e Flexible programming of an S7-300 CPU with a CP 341 as Modbus master for
communication with several slaves

e Programming of an S7-300 CPU as Modbus slave for communication with a
master via an ET200S 1SI module

In the sample project, the CP 341 as Modbus master alternatingly reads two data
words each from the two slaves (ET 200S 1SI).

The user program of the master and slaves designed for the application of the
function codes 3 and 16 is located in the S7-300 CPU.

The exact function mechanisms of the program are described in Chapter 4.

The following figure displays the most important components of the solution:
Figure 2-1
Engineering station

STEP7 V5.5

S7-300 CPU: gé 18| 18I

program for (RTU (RTU (RTU
Modbus master & slave 1) slave 2)

\ \ ET-ZOOS /

]

Modbus slaves

a
a

0000000
[sleleloteYeYe}

DDDDOOO
DDDDOOO

| RS485
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2 Solution

Advantages

2.2 Required hardware and software components

This application offers you the following advantages:
Fast introduction to the subject of Modbus RTU with SIMATIC S7-300
You get encapsulated functions for programming either a Modbus slave or a

Validity

Delimitation

Modbus master

Software versions from STEP 7 V5.5 SP3 on
SIMATIC S7-300 CPUs
CP 341, ET 200S 1Sl

This application does not include an introduction to the subject of SCL
programming.

Basic knowledge of that is assumed.

2.2 Required hardware and software components

The application in STEP 7 V5.5 was generated with the following components:

Hardware components

Table 2-1
Component No. Order number Note
PS 307 5A 1 6ES7 307-1EA01-0AAQ

CPU 315-2 PN/DP

6ES7 315-2EH14-0AB0O

Alternatively, other
CPUs from the S7-
300 spectrum can
also be used.

CP 341-RS422/485

6ES7 341-1CH02-0AEQ

The module with the
RS232 interface is not
suitable for a bus

configuration.
ET 200S 1 6ES7 151-3AA23-0AB0
PM-E DC24V 1 6ES7 138-4CA00-0AAQ
ET 200S 1Sl 2 6ES7 138-4DF11-0BAO
BaseUnit 2 6ES7 193-4CC20-0AA0
BaseUnit 1 6ES7 193-4CB20-0AA0

Note

Entry-ID: 109474714, V1.0,
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2 Solution

Standard software components

Note

2.2 Required hardware and software components

Table 2-2
Component No. Order number Note
STEP 7 V5.5 SP2 HF5 | 1 6ES7810-4CC10-0YAS5
S7-SCL V5.3 1 6ES7811-1CC05-0YAS5

Modbus Master f.
CP341/CP441-2

6ES7870-1AA00-0YAOQ

STEP 7 V12

6ES7822-1AE02-0YAS5

The STEP 7 V5.5
project was migrated to
STEP 7 V12.

Only Chapter 6 "Startup of the application" goes into the differences between
STEP 7 V5.5 and STEP 7 V12. This application is focused on STEP 7 V5.5.

Sample files and projects

The following list includes all files and projects that are used in this example.

Table 2-3

Component

Note

109474714 classic_S7-
300_ModbusRTU_CODE_V10.zip

This zip file includes the archived
STEP 7 V5.5 project.

109474714_TIA_S7-

300_ModbusRTU_CODE_V10.zip

This file includes the archived
STEP 7 V12 project.

DOKU_V10_d.pdf

109474714_S7-300_ModbusRTU_

This document.

For further documentation, for example on the distributed I1/0O ET 200S, please refer

Chapter 8 References.

Entry-ID: 109474714, V 1.0, 04/2013
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3 Basics of the Modbus RTU protocol

3
3.1

Overview

3.1 Function mechanisms of Modbus RTU

Basics of the Modbus RTU protocol

Function mechanisms of Modbus RTU

Modbus RTU (Remote Terminal Unit) is a standard protocol for serial
communication between master and slave.

Other protocols of the Modbus specification such as Modbus ASCII are not
supported by the serial SIMATIC S7-300 CPs.

Master-slave relation

Modbus RTU utilizes a master-slave relation in which the entire communication is
effected from one single master unit. The slaves only respond to the requests from
the master. The master sends a request to a slave address and only the slave with
this slave address responds to the command.

Special case: If Modbus slave address 0 is used, the master communication
module sends a broadcast telegram to all slaves (without receiving a slave
response).

Communication procedure

The communication procedure with Modbus RTU is as follows:
1. The Modbus master sends a request to a Modbus slave in the network.

2. The slave responds with a response telegram in which - if data were requested
- the data are already contained or

3. if the slave cannot process the request of the master, it responds with an error
telegram.

As an example, the following table shows the structure of a telegram if data are to
be read from a or several holding register(s) of the Modbus slave (Modbus
standard).

Table 3-1
Telegram Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5

Request Slave Function Start address (from No. of registers -

address code which holding register
on it is to be read)

Valid response Slave Function Length Register data
address code

Error message Slave 0x83 Error -
address code

Entry-ID: 109474714, V 1.0, 04/2013 8
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3 Basics of the Modbus RTU protocol

3.1 Function mechanisms of Modbus RTU

The function code tells the slave which function to execute. Table 3-2 lists the
function codes that can be used with the CP 341:

Table 3-2
Function code Function

01 Read output bit

02 Read input bit

03 Read holding register

04 Read input words

05 Write one output bit

06 Write one holding register

15 Write one or several output bit(s)

16 Write one or several holding register(s)

07 Read event bit

08 Check slave status via data diagnosis code /
Reset slave event counter via data diagnosis code

11 Read status word and event counter of slave communication

12 Read status word, event counter, telegram counter, and event bytes
of slave communication

Performance data

No. of units on the bus

Table 3-3
Modbus standard No. of addresses
Modbus RTU standard 247; without repeater, the physical limit is
about 30 units.

In the case of line lengths of more than 50 m, a terminating resistor of approx. 330
ohm has to be installed on the receiving side for interference-free data traffic.

Data length
Table 3-4
Instruction type Function codes Maximum no. per request
(CP 341)
Bit instruction 1,2,3,5,15 2040 bits
Register instruction 4,6, 16 127 registers (words)

The respective upper limits of the modules have to be observed.

Entry-ID: 109474714, V 1.0, 04/2013
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

3.2 Configuration in STEP 7 V5.5

Overview

STEP 7 allows the configuration of Modbus RTU communication. This section
demonstrates

e which settings have to be made in the hardware configuration and
e which properties the instructions for Modbus RTU communication have.

Requirements

In order to configure and program Modbus RTU communication, the loadable driver
blocks for STEP V5.5 are required first.

These drivers can be found at the following sources:

e Loadable Driver Modbus Master (RTU) for CP 341 and CP 441-2
http://support.automation.siemens.com/WW/view/en/27774018

e Loadable Driver Modbus Slave (RTU) for CP 341 and CP 441-2
http://support.automation.siemens.com/WW/view/en/27774276

e Function Blocks, Examples and User Manuals of the Serial Interface
ET200S 1Sl

http://support.automation.siemens.com/\WWW/view/en/25358470
Install the packets you need.

The configuration of the Modbus functions depends on the module used. For
detailed information, please refer to the manuals stated in Chapter 8 "References".

Licensing

For communication as Modbus master, a software license is required as well as the
corresponding dongle for the CP 341.

¢ MODBUS software license for CP 341 / CP 441-2
http://support.automation.siemens.com/\WW/view/en/13211560
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

3.21 Configuration of the CP 341 as Modbus master

Hardware configuration

If the CP 341 is to be operated as Modbus master, the following settings have to be
made in the hardware configuration:

Table 3-5
No. Instruction Remarks
1. | Open your project. @) SIMATIC 300(1) (Kenfiguration) --
Change to the
HW Config and select
the CP 341. =0 UR
1 PS5 307 2A
2 CPU 3152 PN/DF
X7 HFJ"/E'F
X2
XPTR Fo.rf 7
XFP2R Port 2
4 [ CP341-R5422/485
2. RIght-ClICk and go to BT} Assigning Parameters to Paint-To-Point Connections - [CP 341-RS422/485 (RO/S4) --\S
"ObjeCt PrOpertieS> File Edit View Options Help
Parameter. ) _" and Properties - CP 341-R5422/485 - (R0/54) J J
select the "MODBUS Gert s e ypms || P
Master“ protocol Short Description: CP 341-RS422/485
Som ot
Order No.: 6EST 341-1CHO1-0|
Hams CEETE
Pratocol
Load Drivers
2 P Press F1 for help.
3. Download the Modbus | 'Load Drivers (=25
master drivers to the i i :
CP by double—clicking Driver version online on module
on the gray "Load Driver name: STWFPATX
Drivers" icon. Driver version: 2E
Diriver werzion offline on pragraming unit
Crriver name: STWFRAT
Driver version: 26
Downloading to module:

Entry-ID: 109474714, V 1.0, 04/2013 11
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

No. Instruction Remarks
4, After having double- Make sure that the master is assigned the same communication
clicked on the settings as the slave!
"Protocol" icon you can | Example:
set the communication Protocal ==
parameters inthetabs || .
"Modbus Master" and General ; Modbus-Master | interface |
"Interface”. Speed Character Frame
Baud Fate: Data Bits: Stop Bits: Parity:
9600 v| Bisss S| 1 = [even |
Protocol Parameters
Reply Montoring Time:  [2000  ms | [~ apaple Operating Mode Selection at RS485
Operating Mode: Inteference Suppression J
Muttiplier Character delay time: 1 AZ:I
s |t |
Protocol IEI
General | Modbus-Master
Operating Mode Presetting of the Receiving Line
" Full-Duplex (RS 422) Four-Wire Operation " Mone
* Half-Duplex (RS 485) Two-Wire Operation ]
+ Signal R{&) O Vot
Signal RiB) 5 Volt
s | bt
With these settings, break recognition is not possible.
5. Finally load the

modified hardware
configuration to your
CPU.

i |

Entry-ID: 109474714, V1.0,
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3 Basics of the Modbus RTU protocol

Communication blocks

3.2.2

Note

3.2 Configuration in STEP 7 V5.5

Table 3-6

Element Symbolic name Description

FB7 P_RCV_RK In reading function codes, the response telegram
from the slave is received with the function block
P_RCV_RK (FB7) and the data are stored in the
receive buffer specified at the parameters DB_NO
and DBB_NO.

FB8 P_SND_RK The function block transfers a communication job to a
slave, with the data stored in a source data area.

A detailed description of the configuration is contained in the manual \3\, most of

all in Chapters 6 and 7.

Configuration of the ET 200S 1Sl as Modbus slave

Hardware configuration

If the ET 200S 1SI module is to be operated as Modbus slave, the following
settings have to be made in the hardware configuration:

Table 3-7

No.

Instruction

Remarks

1.

Open your project.
Change to the

HW Config and select
the 1Sl module in the
ET 200S.

The number of bytes defines which "bandwidth" per cycle is reserved in
the ET 200S for serial communication of this module.

The number of bytes impacts

e the data transmission rate

e the modules that can be inserted additionally in the ET 200S
: - 1 51 Modbus Slave

2. Right-click and go to
"Object Properties>
Parameter...".
3. | Adjust your Make sure that the slave is assigned the same communication
communication settings as the master!
parameters. For example:
Entry-ID: 109474714, V 1.0, 04/2013 13
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

modified hardware
configuration to your
CPU.

man |akin || [

No. Instruction Remarks
General | Addresses | dertification FParameters |
Farameter Walue
— a 0313 =t =
[£] Enable Module Diagnosis []
[£] Activate BREAK indicator [ ]
[Z] Interface RE485 (half duplex)
[£] Receive Line Initial State R(A) OV R(B) 5V
[£] Operating mode Mormal Operation
[£] Slave address 5
[£] Data flow contral
[Z] Data rate 9600
[Z] Stop bits 1
[Z] Parity even
[£] Expiration character time multiple 1
[£] Time to RTS = off after transmission (ms)
[£] Data output wait time (ms)
[£] Delete receive buffer during CPU startup
4. Finally load the

Communication blocks

Note

Table 3-8

Element Symbolic name Description

FB81 S_MODB By initializing S_MODB (FB81), the 1SI module is set
as Modbus slave and telegrams received from a
master are processed by the function block S_MODB
(FB81).

FB2 S _RECV_SI Realize the communication between CPU and

FB3 S SEND SI module; internally, the FBs are used by the function

- - block S_MODB (FB81).

Entry-ID: 109474714, V1.0,
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4 Description of the STEP 7 program

4
4.1

Functions

4.1 Overview

Description of the STEP 7 program

Overview

The S7 program realizes the following functions:

e Communication of the S7-CPU as Modbus master (via the CP 341) for cyclic
reading of two words each from two Modbus slaves.

¢ Communication of the S7-CPU via the distributed I/O (ET 200S with 1Sl
modules) as Modbus slave

The communication program for the master as well as that for the slaves is realized
in the SIMATIC S7-300 CPU.

The sample program can be adjusted to your requirements. Please read Chapter 5
on that.

Program overview

Figure 4-1

Global

parameters

P_RCV_RK

l One cajf

per siave

cyclic
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4.1 Overview

Blocks and instructions
The following blocks are used in the STEP 7-V12 project:

Table 4-1
Element Symbolic name Description
OB1 CYCLE Contains the main program:
calls the FB Modbus_Master (FB5) and for
each slave the FB S_MODB (FB81). =
0OB100 RESTART e Parameters for the master for ;
communication with the slaves are ©
initialized. ?
e Parameters for the slaves are initialized. o
e The FB Modbus_Master (FB5) is
initialized with a call.
FB5 Modbus_Master A communication module is set as Modbus
master. The function block manages all
communication jobs to a or several Modbus
slave(s).
DB4 Master_Data Contains parameters for the FB
Modbus_Master (FB5) and the buffers for
communication jobs from the master.
DB5 |_Modbus_Master Instance DB of the FB Modbus_Master (FB5) -
DB100 CONVERSION_DB_x | Is added to the calling of the FB S_MODB é
DB200 (FB81) and defines - dependent on the g
function code - at which location incoming and | 3
outgoing data are to be stored. é
DB101 Slave_Data_x Data storage for one communication module o
DB201 (1SI) each. 3
<
DB102 I_S_MODBXx Instance DB of the FB S_MODB (FB81) =
DB202
DB103 Para_Slave_x Contains parameters for the calling of the FB
DB203 S_MODB (FB81).
UDT1 Data_for_Master Contains parameters for the creation of a
Modbus telegram.
uDT2 Slave_Para Contains parameters for the calling of the FB
S_MODB (FB81).
FB2 S _RECV_SI For communication between the CPU and 1Sl
FB3 S SEND SI module of the distributed 1/0. The function
- - blocks are called internally by the FB
S_MODB (FB81).
FB7 P_RCV_RK Communication instruction for receiving data
as Modbus master. "
Is called internally by the FB Modbus_Master 'té
(FB5). 5
FB8 P_SND_RK Communication instruction for communication 5
as Modbus master. 2
Is called internally by the FB Modbus_Master »
(FB5).
FB81 S_MODB In each call: an already parameterized
communication module is set as Modbus
slave for communication with a Modbus
master.

Entry-ID: 109474714, V 1.0, 04/2013 16
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)
4.2 Function mechanisms of the FB Modbus_Master (FB5)

421 Calling the FB Modbus_Master

Task

The FB Modbus_Master (FB5) manages the communication jobs of the CP 341 to
the Modbus slaves.

Calling and parameters of the FB Modbus_Master

The figure shows the call interface of the FB Modbus_Master (FB5). The
parameters are described in Table 4-2.

Figure 4-2
222
"Modbus Master"
. —EN
PORT
. —MASTER

. —No_Slaves

ERROR—, ..
DB No
. —Comm_Data STATUS—. ..
. —{INIT ENO|—
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

The FB Modbus_Master has the following input and output parameters:

Table 4-2
Parameter Type Remarks
PORT_MASTER IN: Start address (LADDR) of the master
INT communication module; can be taken from the
hardware configuration.
Properties - CP 341-R5422/485 - (R0O/54)
General Addresses | Basic Parameters |
Inputs
Start: @ Process image:
End: 7 ===
No_Slaves IN: Number of active communication jobs stored in
INT the DB Master_Data (Master_comm array).
No_DB_Master_Data | IN: Block number of the DB Master_Data.
INT
INIT IN: For INIT = TRUE, the communication jobs in
BOOL the Master_comm array the station addresses
of which have the value zero are locked.
For INIT = FALSE, the communication jobs are
processed in the DB Master_Data.
ERROR OUT: ERROR = TRUE if an error is pending in the
BOOL block.
STATUS OUT: STATUS of the block. More detailed
DWORD information is given below.

Output parameter: STATUS

Table 4-3

Status

Description

High Word

Indicates at which station address (at which slave) the status occurred.

Low Word

Status of the block at which the error occurred.

If all station addresses in the DB Master_Data have the value 0, the value of
STATUS is 16#FFFE.

Entry-ID: 109474714, V1.0,
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

422 Initialization

Overview

The "INIT" status is triggered by calling the FB Modbus_Master (FB5) in OB100 in
the first cycle with INIT=TRUE. In the user program itself, the status can be
recalled several times with INIT=TRUE.

In this status, parameters required for the program run are initialized.

Remarks

It is ensured that a positive edge is
created at the control input.

Address 0 serves as broadcast in
Modbus communication.

Description
Table 4-4

No. Process

5. Resetting of the REQ input of the FB
P_SND_RK (FB8).

6. Resetting of the counter variables used
in the function block, which are
incremented each time ERROR=TRUE
or DONE=TRUE occurs.

7. Locking of the slaves with the Modbus
station address=0.

8. Definition with which slave
communication is started.

Communication is started with the first
slave the Modbus station address of
which in the Master_Comm array is not
equal to 0.

Entry-ID: 109474714, V 1.0, 04/2013
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

4.2.3 Cyclic processing of the communication jobs

Overview

After successful initialization of the parameters, the FB Modbus_Master (FB5) is in
the status "cyclic processing of communication jobs".

In this status, the communication jobs are sent to the Modbus slaves and the
communication is managed.

Program code: calling of the communication blocks

Figure 4-3

ffecaleulation of the byte-address of the modbus telegram - information

control .DEE NO 5 := (control.number-1)*26+4;

ffcalculation of the length of the data of the modbus telegram

IF "Master_ Data".Master comm[control.number].Comm Param.functioncode = 16%3 THEN
survey.lengthl:=g;

ELSIF "Master Data".Master comm[control.number].Comm Param.functioncode = 16710 THEN
survey.lengthZ:=(("Master Data".Master comm[control.number].Comm Param.reg number)*Z) +&;
END IF:

;fcgl; of the FEE F_SND RK
Master_ Instance_ 5 (

S5F := '5'// IN: CHRR

(REQ := control.req master // I

,LLDDR := PORT MASTER/,/ IN:

(DB NC := DB No Master Data/

,DBE_NO:= control.DEB NO 5 //

(LEN := survey.length2// IN:
)i
control.req master := 1;
survey.done master := Master_ Instance S.DONE; // OUI: EOOL
Survey.err master:= Master Instance 5.ERROR; // OUT: BOOL
stat = Master Instance 5.5TATUS: // OUL: WORD
//call the FBT P_RCV_BK TO receive
// the answer of the modbus slave
control.DBE NO R := (control.number-1)=26+10;
Master_ Instance R (

EN R := 1
(LADDR := PORT MASTER// IN: INT

(DB _NO := DB No Master Data
DBE_NO:= control.DBE NO R
)
survey.length := Master Instance R.LEN;
survey.ndr := Master Instance R.NDR;
survey.errR:=Master_ Instance_ R.ERROR:
survey.statusk := Master_ Instance_ R.S5TATUS;

Description
Table 4-5

No. Process Remarks

9. The input parameters DBB_NO and
LEN for calling the FB P_SND_RK
(FB8) are calculated on the basis of the
current control number.

10. The FB P_SND_RK (FB8) is called with | If you want to modify the jobs to the
the parameters from the active UDT Modbus slaves, please refer to
Data_for_Master. Section 5.2.

As response to the sent telegram, the
slave sends the requested data to the
master.
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

received and the data contained therein
are stored in the receive buffer for the
slave (in the DB Master_data,
Master_comm array).

No. Process Remarks
11. The FB P_RCV_RK (FB7) effects that The FB P_RCV_RK (FB7) is always
the response telegram of the slave is called.

Program code: evaluation of the parameters
Figure 4-4

/fanalysis of the output parameters

IF survey.done master OR survey.err master THEN

IF survey.err master THEN
f/=save error and count
control. save number := control.number;
Survey. EII_C ou.nt,_gen i= survey. EII_C ount,_gen +1;
survey.stat_save_comm:=stat;
IF survey.errR THEN

survey. status_saveR = survey.statusR:
END_IF;
control.req master := 0; //reset the reg input of the Modbus_Master instruction

"Master Data".Master comm[control.number].Diagnostic.ERROR:=1;
"Master Data".Master comm[control.number].Diagnostic.S5TATUS:= stat:
ELEE

‘zave done and count
//=ave number for data-transfer
survey.done_count_gen := survey.done_count gen +1;
"Master Data".Master comm[control.number].Diagnostic.ERROR:=0;
"Master Data".Master comm[control.number].Diagnostic.STATUS: 0z
control.req master:=0;
END IF;
after there is an error or a done on the function blocks:
//change Modbus station address
IF control.change = 1 THEN
IF control.number < No_Slaves THEN
WHILE ("Master Data".Master comm[control.number+l].Diagnostic.LOCEK)

control.number:=control.number +1:
END WHILE;
END_IF;
control.number:=control.number +1:

IF control.number >No Slaves THEN
control.number:=survey.first unlocked;
END_IF:
END_IF;
END IF:

Entry-ID: 109474714, V 1.0, 04/2013
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4 Description of the STEP 7 program

Description
Table 4-6

4.2 Function mechanisms of the FB Modbus_Master (FB5)

No.

Description

12.

If the FB P_SND_RK (FB8) returns ERROR=TRUE, the status is stored, an
error counter is incremented, and the request input is reset.

The resetting of the request input triggers a new communication job in the next
cycle.

13.

If the FB P_SND_RK (FB8) returns DONE, a done counter is incremented and
the request input is reset.

The resetting of the request input triggers a new communication job in the next
cycle.

14.

After ERROR=TRUE as well as after DONE=TRUE, the next element in the
Master_comm array is marked as active.

With the following cycle of OB1, the next communication job is started.
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4 Description of the STEP 7 program

4.2.4

Overview

Structure

Use

4.2 Function mechanisms of the FB Modbus_Master (FB5)

The UDT Data_for_Master

The UDT (User Defined Datatype) Data_for_Master contains the information

relevant for the FB Modbus_Master (FB5) about the communication with a Modbus

slave. The Master_comm array in the DB Master_Data consists of UDTs

Data_for_Master.

Figure 4-5 shows the structure of the UDT Data_for Master.

Figure 4-5
Address |Name Type
0.0 STRUCT
+0.0| |[Diagnostic STRUCT
+0.0 LOCE BCOL
+0.1 EERCE BOOL
+2.0 STATUS WCORD
=4.0 END STRUCT
+4.0| |Comm Param STRUCT
+0.0 address BYTE
+1.0 functioncode BYTE
+2.0 reg startaddr |WORD
+4.0 reg number INT
=6.0 END STRUCT
+10.0| |buffer BRBRAY[0..7]
*2.0 WCORD
=26.0 END STRUCT

The sample project contains an array of two UDTs Data_for_Master in the DB

Master_Data.
The parameters
e address

e functioncode
e reg_startaddr
e reg_number

specify the job of the master for the slave. More detailed information on the use of

the Modbus function codes can be found in the manual \3\, Chapter 6.
If you want to communicate with further slaves or read/write other data areas,

please refer to Chapter 5.

Entry-ID: 109474714, V 1.0, 04/2013
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4 Description of the STEP 7 program

4.3 Function mechanisms of the Modbus slave

4.3 Function mechanisms of the Modbus slave
4.3 Calling the FB S_MODB (FB81)
Task

The function block S_MODB (FB81) receives the Modbus protocol and converts
the Modbus addresses into SIMATIC memory areas.

Calling and parameters

Figure 4-6
"S_-M-O-DB"
.. —EN
.. —LADDR
START
.. —|TIMER
START
.. —TIME
.. —DB_No
.. —OB MASK
.. —CP_START
CP START
.. —FM B
.. —CP NDR
CP START
.. —oK B
CP_START
.. —ERROR
.. —ERROR_NR
ERROR
.. —INFO ENOR
Table 4-7
Parameter Type Remarks
LADDR IN: HW identification (LADDR) of the slave
INT communication module; can be taken from the
hardware configuration.
Properties - 1 5 Modbus Slave (32 B) - (R-/52)
General Addresses | Identification | Parameters |
Inputs
Start: E Process Image:
End: 319
START_TIMER IN: Timer for aborting the initialization of the function
Timer block after a defined period of time.
START_TIME IN: Maximum time that may elapse for the initialization
S5TIME of the block.

Entry-ID: 109474714, V 1.0, 04/2013
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4 Description of the STEP 7 program

4.3 Function mechanisms of the Modbus slave

Parameter Type Remarks
DB_No IN: Number of the data block that contains the
BLOCK_DB | conversion table (CONVERSION_DB_ x).
OB_MASK IN: In the case of TRUE, access errors in the I/O area
BOOL are masked and in the case of write access to
nonexistent I/O, the CPU does not STOP.
CP_START IN: Starts the initialization.
BOOL
CP_START_FM IN: Is set by the FB S_MODB (FB81) itself. Has to be
BOOL set to 0 during initialization.
CP_NDR OUT: Indicates if data from the master have been written
BOOL in the slave data area.
CP_START_OK OUT: CP_START_OK=TRUE if the initialization of the
BOOL function block has been successful.
CP_START_ERROR | OUT: CP_START_ERROR=TRUE if the initialization of
BOOL the function block has not been successful.
ERROR_NR OUT: Error number
WORD
ERROR_INFO OUT: Additional error information
WORD For more information about ERROR_NR and
ERROR_INFO, please refer to the manual \7\,
4.3.2 Blocks
Overview
In the sample project, the following data blocks are required for calling the FB
S MODB (FB81):
e CONVERSION_DB x
e Slave_Data_x
e | S MODBx
e Para_Slave x
For slave 1 these are the data blocks 100-103, for slave 2 the data blocks 200-203.
DB I_S_MODBXx

The data block I_S_MODBKXx is the instance data block of the FB S_MODB (FB81).
The data block is generated automatically as soon as the FB S_MODB (FB81) is

called.

DB CONVERSION_DB_x

The data block CONVERSION_DB_x informs the FB S_MODB (FB81) at which
location - dependent on the function code used - the data received from the master

Entry-ID: 109474714, V1.0,

are to be stored.

Figure 4-7 shows the structure of the CONVERSION_DB_X. The entry marked in
red applies to the function codes 3 and 16 used here (and also to function code 6
which is not used here).
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4.3 Function mechanisms of the Modbus slave

Also relevant are the parameters DB_MIN and DB_MAX since these restrict the
access to the data blocks.

Figure 4-7
+0.0| |FCO1_MOD_STRT_ADR_1 |WORD WELEE0
+2.0| |FCO1_MOD_END ADR_1 |WORD WELEEFF
+4_.0| |FCO1_CNV_TO _FLAG A |WORD WELEE0
+e.0| |FCO1_MOD STRT ADR 2 |WORD Wgleglo0
+8.0| |FCO1_MOD END_ADR_Z |WORD WELGELFF
+10.0| |FCO1_CWV_TO_COUTEUT WORD WELE£0
+12_0| |FCO1_MOD STRT_ADR 3 |WORD WELleg200
+14_0| |FCO1_MOD END ADR 3 WORD WELefZFF
+1&._0( (FCO1_CHV_TO_TIMER WORD WELE£0
+18.0| |FCO1_MOD STRT_ADR 4 |WORD WEleg300
+20_0| |FCO1_MOD END ADR 4 WORD WELEE3FF
+2z_ 0| (FCO1_CHWV_TO_COUNTER |WORD WELE£0
+24_0| |FCOZ_MOD_STRT_ADR 5 |WORD WELGEEO
+26.0( |FCOZ_MOD END RDR S |WORD WELERFE
+28.0( |FCOZ_CWMV_TO FLAG B |WORD WELERD
+30_0( (FCOZ2_MOD _STRT_RDR & |WORD WEleg100
+32_0| |FCOZ_MOD END_RDR & WORD WELEEZFF
+34_0| |FCOZ_CHWV_TO_INPUT WORD WEle0
+36.0| fFCo3_06_ 14 DB _NO WORD WELEECD |
+38.0( [FCO4_ DB NO WORD WELGECo
+40_0| |DB_MIN WORD WiElegCo
+42_0| |DB_MAX WORD WglegCo
+44._0| |FLAG MIN WORD Wgleg0
+46_ 0 (FLAG MRX WORD WELEEFF
+48_0| |OUTEFUT_MIN WORD WELE£0
+50_0| |CUTEPUT MR WORD WELEEFF

In the sample project, the data of the function codes 3 and 16 are stored in the
data block Slave_Data_1 (DB101), according to the specification in
CONVERSION_DB_1, orin Slave_Data_2 (DB201), according to the specification
in CONVERSION_DB_2.

Slave_Data_x

In the data block Slave_Data_x, a slave stores the data received from the master
(with function code 3).

If data are read from the master (with function code 16), the data stored in
Slave_Data_x are sent to the master, according to the specification in
CONVERSION_DB_x.

DB Para_Slave_x

In the DB Master_Data, the parameters for interconnection with the inputs of the
FB S_MODB (FB81) are stored.

The relevant parameters are initialized upon CPU start in the OB RESTART
(OB100).
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4.4 The DB Master_Data

4.4 The DB Master_Data

Overview
In the DB Master_Data, data for the FB Master_Modbus (FB5) are stored that are
required for Modbus RTU communication.
Structure
Figure 4-8 shows the structure of the DB Master_Data.
Figure 4-8
Addreas Name Type
0.0 STRUCT
+0.0| |[Master comm RRRRY[1..2]
*26.0 "Data_for Master™
+52_0| |Master INIT BOOL
+52_1| |Master ERROR BOOL
+54_0| |Master STATUS DWORD
Use
Table 4-8
Name Data type Use Remarks
Master_comm Array[1..2] of For the use of the UDTs Parameters are used in
"Data_for_Master" | Data_for_Master, please refer | the FB Modbus_Master
to Sections 4.2.4 and 5.2. (FB5).
Master_INIT BOOL Are interconnected with the
Master ERROR BOOL input and output parameters
Master STATUS WORD of the FB Modbus_Master
- (FB5).
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5 Configuration

5

Overview

5.1

Overview

5.1 Modifying communication settings

Configuration

This chapter provides support if you want to modify the STEP 7 project.
The following adjustment options are documented:

e Modifying communication settings such as the baud rate of the Modbus master
and the two Modbus slaves

¢ Modifying existing communication jobs
e Adding further communication jobs to the program

e Adjusting the receive buffer size in order to send or receive data larger than 8
words

Modifying communication settings

Your Modbus master and your Modbus slaves need to have identical
communication parameter settings to be able to communicate with each other.

The communication parameters for the CP 341 as well as for the ET 200S modules
1SI are set in the HW Config.

Procedure for CP 341 and ET 200S 1SI

5.2

Overview

Proceed as follows to modify the communication parameters of your
communication modules:

o for CP 341, please refer to Section 3.2.1
o for the 1SI module, please refer to Section 3.2.2

Modifying existing communication jobs

The sample project contains two communication jobs on the basis of which the
Modbus master alternatingly reads cyclically 2 words of data each from the two
Modbus slaves.

This section describes how to modify the parameters for the communication jobs.
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5.2 Modifying existing communication jobs

Procedure
Table 5-1
No. Instruction Remarks
15. Open the OB RESTART (OB100). EHE S.'-"-F'ru:ugrliamm['l] 0B 100 RESTART
g S”E - FuNE 5_RECV_SI
wsEnE | g a3 5_SEND_SI
16. Adjust the move commands in the Name Meaning
first t'WO networks to your address Modbus slave address of the
requirements. Thus change the slave with which communication
parameters of the Master_comm is to be effected
array in the DB Master_Data. functioncode Function code used. The sample

project is tested with

o 16#3: write data in holding
register

e 16#10: read data from

If you want to change the size of
the registers to be read/written,

please refer to Section 5.4. holding register
reg_startaddr Start address of the read/write
access
reg_number Number of registers to be
read/written

17. Download the OB to your CPU
and restart the CPU.

Note The data the master receives from the slave or sends to the slave are stored in
the DB Master_Data in the buffer of the corresponding communication job (an
element of the Master_Comm array).
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5 Configuration

5.3

Overview

Description

5.3 Adding further communication jobs

Adding further communication jobs

If you want to have more than the two existing communication jobs processed by
the master, the sample project has to be modified.

A differentiation is to be made

e whether only an additional communication job is to be sent to an existing slave
or

e an additional slave is to be programmed, for which then also a communication
job is to be created on the master side.

Via the No_Slaves input, the FB Modbus_Master is informed how many
communication jobs it has to process. For each communication job, a UDT has to
be created in the Master_comm array in the DB Master_Data.

If a slave is to send as well as receive data, it is recommended to expand the
Master_comm array by an additional job. The same applies for the communication
with another slave.

Table 5-2 lists the parameters that need to be set for communication with a slave.

Figure 5-1
Address (Name Type
0.0 STRUCT
+0.0| |[Diagnostic STRUCT
+0.0( |LOCE BOOL
+0.1| |ERRCR BOOL
+2.0| |sTATUS WORD
=4.0 END_STRUCT
+4.0| |Comm Param STRUCT
+0.0 address BYTE
+1.0 functioncode BYTE
+2.0 reg startaddr |WORD
+4.0 req number INT
=6.0 END_STRUCT
+10.0| |buffer ARRAY[0..7]
*2.0 WORD
=26.0 END STRUCT
Table 5-2
Variable Function Remarks
address The Modbus station address Enter the station address of the slave
of the slave. configured in the HW Config.
[£] Slave address E
functioncode Indicates the kind of request. The sample project is designed for the
use of function codes 3 and 16.

Entry-ID: 109474714, V1.0,
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5 Configuration

5.3 Adding further communication jobs

Variable

Function Remarks

reg_startaddr | Indicates at which register
address reading or writing is to
be started.

written.

reg_number Indicates the number of
registers that are to be read or

Note Via the parameters ERROR and STATUS it is possible to read out the status of
the communication to the respective slave in operation.
5.3.1 Procedure for Modbus master
Table 5-3 describes the procedure for adding a new communication job to the
existing communication jobs, for example to another slave.
Table 5-3

No. Instruction Remarks

18. | Open the DB Master_Data.

19. | Add a new element to the Master comm
Master_Comm array in the DB — -

"Data for Master™
Master_Data. = =
o5 |RRRAY¥[1..3]

20. | Add new networks in OB100, in For more detailed information on the meaning of the
which you set the parameters individual parameters, please refer to Chapter 5 or to the
e address (take the station manual \3\.

address of your slave from the
HW Config)

e functioncode
e reg_startaddr
e reg_number
of the added array element.

21. | In OB1 and OB100, increment the
input parameter of the FB
Modbus_Master (FB5) No_Slaves
by 1.

22. | Download your project to the CPU.

Now your Modbus master
additionally processes the added
communication job.
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5 Configuration

5.3 Adding further communication jobs

5.3.2 Procedure for Modbus slave

If you want to program a slave, you need to adjust your user program as well as
the hardware configuration.

HW Config

Add a new ET 200S SI module in the HW Config. For setting the parameters of the
module, please refer to Section 3.2.2.

User program

Table 5-4
No. Instruction Remarks
23. Create a new DB Para_Slave (for example,
with the number 303).
24. Create an element of the data type Hane Type
"Slave_Para" in the DB.
STRUCT
Para Slave_3 |"Slave_ Para"

25. Add new networks in OB100, in which you set
the parameters

e LADDR (take the start address of the
input parameters from the HW Config)

e CP_START =1
e CP_START_FM=0
of the newly created DB.
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5 Configuration

5.3 Adding further communication jobs

No. Instruction Remarks

26. Create a new CONVERSION_DB_x block (for | If you only use the function codes 3 and 16,
example, DB no. 300) and modify the initial you have to
values of the DB as desired. e assign the number of your buffer DB to the

variable "FC03_06_16_DB_NO"

o set the variables DB_MIN and DB_MAX
such that the number of the buffer DB is
included in their range.

27. Copy one of the Slave_Data_x blocks and In the sample program, a buffer of 2 words is
change the number of the DB in the properties | sufficient since no send or receive jobs with
to the number specified in the larger amounts of data are issued.
CONVERSION_DB_x. For larger jobs, please refer to Section 5.4.

28. Call the FB S_MODB (FB81) in a cyclic OB DB7
and transfer the identical parameters of the
DB created in the DB Para_Slave_x (under
1.).

The following parameters have to be assigned
individually:
e START_TIMER -
Use a free timer resource. DR2 _DEW100
e START_TIME oo
A time of S5T#5S is sufficient. e e
e DB_NO
STRRT
Specify the number of the T4 —|TIMER
CONVERSION_DB created under 4. .
« OB_MASK Rl i S
Masking; is TRUE in the example.
29. Download your project to the CPU.

The slave is now ready for communication
with the master.
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5 Configuration

5.4 Adjusting the receive buffers

54 Adjusting the receive buffers
Overview
The sample application reads two words from a slave upon one request. The
buffers used in the program have a size of two words.
If you want to read or write larger amounts of data, you have to make the
modifications described in Section 5.2 and additionally you have to enlarge the
buffers used.
Procedure
Table 5-5
No. Instruction Remarks
30. Open the UDT1
Data_for_Master and change the
"buffer" array to the desired size.
31. Open the DB Master_Data. Hame Type Initial val|Comment
Resolve the time stamp conflict Fomeen
by selecting the respective line Master comm  |ARRAY([1..Z2]
"Data_for_Master" in the ‘Datar
variables detailed view and then sTRUC] Opem lert i
the context menu command STAT1 STRUC] Update Declarations
"Update Declarations". ETATZ BOOL
STATS BOOL Object Properties Alt+Return
32. In the DBs Slave_Data_x, Name Type
change the "buffer" arrays to the STRUCT
size already used under 1. buffer RRAYIO. 7]
|WDRD
The ET 200S 1SI can send a maximum of 110 registers per
job or receive a maximum of 109 registers.
Information on the maximum size of a write/read job can be
found in the manuals \3\, \4\, and \7\ in the chapters on the
Modbus function codes.
33. Download all blocks to your
CPU.
Now you can issue even larger
send and receive jobs.
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6 Startup of the application

6.1 Hardware configuration

6 Startup of the application

6.1 Hardware configuration

Overview
The figure below shows the hardware configuration of the example.

Figure 6-1
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The tables describe the hardware configuration procedure of the project.
Please observe the regulations for the configuration of an S7 station.

Hardware configuration of the SIMATIC S7-300 station

Table 6-1
No. Instruction Remarks
34. Insert the power supply, CPU, and CP in the | Do not forget to insert the backplane bus
corresponding rack. between CP and CPU.

35. Wire the CPU and CP with the power supply. | Mind the correct polarity!

36. Connect your power supply with the power
grid (230V AC).

37. Connect the CPU to your engineering station | A connection via MPI or PROFIBUS from
with STEP 7 V5.5 via Ethernet. your PG to the CPU is also possible.
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6 Startup of the application

Hardware configuration of the ET 200SP

6.1 Hardware configuration

Table 6-2
No. Instruction Remarks
38. Insert the front module, the power module, Observe the instructions in the manual \6\!

and the 1SI modules with base unit as well as
the termination module in a top-hat rail.

the power supply module.

39. Connect the front module with the SIMATIC
S7-300 via an Ethernet cable.
40. Connect the 1SI modules of the ET 200S with | Note
each other and with the CP 341 of the In the case of lengths of more than 50 meters
SIMATIC S7-300 (see Figure 6-2). your Modbus bus requires two terminating
resistors.
41. Connect the ET 200S to the power supply of

Figure 6-2
CP341 ET200S 15I
B)
p
AN I
_2 .
15 P4 7 oo
14 _' . 6
13 ;—J © 5 RT(A)- | OO .
12 (O - @[5
1 || || SIS | ——
10 @) )5 2 ® 6
9Ol EE
A — 1IN 31007
O / Qe
| @ 4 +=88 PE
\ I.\-.__{,//J
4 R (ANT (A) - Input
Inputfoutput
5 - -
Mode: Half duplex
6 - - Terminals
- - 1 RIT (A)-
9 T+ Output 8 PE ground
10 |- -
11 R (BYT (B) + Input
Inputfoutput
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6 Startup of the application

6.2

Hardware configuration

Configuration of the ET 200S

6.2 Hardware configuration in STEP 7 V5.5

in STEP 7 V5.5

Table 6-3
No. Instruction Remarks
42. Open STEP 7 V5.5. Edit Ethernct Node
Search for "Nodes accessible online". Ethernet nods
Nodes accessible online
To this end, navigate to "PLC> Edit Ethernet T
Node> Browse...". address: L_Browse. |

Your ET 2008 station is now recognized.

43. Select your ET 200S station and confirm with Your station is clearly recognizable by the
"OK". MAC address.
44, Enter the following device name used in the AesgiED T
prOjeCt Dievice name: [IM151-3PN I Azsign M ame I
IM151-3PN
Confirm the action with "Assign name".
The S7-300 station is now assigned the
PROFINET name of your engineering station.
Configuration of the SIMATIC S7-300 CPU
Table 6-4
No. Instruction Remarks
45. | Open STEP 7 V5.5. Edit Ethernet Node
Search for "Nodes accessible online". Ethermet node
Modes accessible online
To this end, navigate to "PLC> Edit Ethernet
Node> Browse...“. MAC addiess: I Browse I

Your SIMATIC S7-300 station is now
recognized.

46.

Select your SIMATIC S7-300 station and
confirm with "OK".

Your station is clearly recognizable by the MAC
address.
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6 Startup of the application

6.3 Retrieving

and downloading the project in STEP 7 V5.5

No. Instruction Remarks
47. | Enter the following IP address used in the Set IP configuration
device for your station: & Use P ;
IP address: 192.168.0.2 S I PR
Subnet mask: 255.255.255.0
Confirm the action with "Assign IP IF address: |.| 92 16E.0.2
Configuration". —
The S7-300 station is now assigned the IP .
address of your engineering station. Subnet mask: |255'255'255'D
" Dbtain IP address from a DHCP server
|dentified by
(v i
Clhent [D:
Azzign 1P Canfiguration I
6.3 Retrieving and downloading the project in STEP 7 V5.5

Retrieving the project

Table 6-5
No. Instruction Remarks

48. Load the file "109474714_classic_S7-
300_ModbusRTU_CODE_V10.zip" to a local
directory on your PC.

49. Open STEP 7 V5.5 and select "File>
Retrieve".

50. Browse to the storage location of the project
directory and select it with a double-click.

51. Select a destination directory for unpacking the | 'Select destination directory ==
project. &1 S7HGYS A

By clicking "OK" the project is retrieved.

L STMANLAL
. sTmap

m

I aK I Cancel Help
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6 Startup of the application

6.3 Retrieving and downloading the project in STEP 7 V5.5

Downloading the project to the CPU

Table 6-6
No. Instruction Remarks
52. | Make sure that your engineering

station is located in the same subnet
as the S7-300 CPU.

Example:
IP address: 192.168.0.251
Subnet mask: 255.255.255.0

Internet Protocol Version 4 (TCP/IPv4) Properties

General

You can get IP settings assigned automatically if your network supparts
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

[ ==

() Obtain an IP address automatically
(@ Use the following IP address:

process by clicking on "Start".

After successful downloading, a
report is opened.

IP address: 192 . 168 . 0 . 251
Subnet mask: 255,255,255, 0
Default gateway:
53. | The PG/PC interface is set via Set PG/PC Interface - [
"Options> Set PG/PC Interface..." to
the local Ethernet card connected Access Path | LLDP / DCP | PNIO Adapter |
with the CPU.
Arcess Poirt of the Application:
STONLINE  (STEP7)  — TCPAP - Intel{R) PRO/1000 MT-N..
(Standard for STEP 7)
Interface Parameter Assignment Used:
TCR/IP - Intel(R) PRO/1000 MT-N...
[ TCP/IP -> Intel{R) PRO/1000 MT
B TCP/IP(Auto) -> Intel(R) PRO/1000_] Copy...
B TS Adapter = Nelete
:‘—| 1 3
(A=signing Parameters to Your NDIS CPs
with TCP/IP Protocal (RFC-1006))
Interfaces
Add/Remove: Select ...
[ Coen | [ e
. [ [—n n "
54. Selgct your $IMATIQ §7-300 station .E A pen Object e g::aLt:on configural
by right-clicking on it. Open "PLC> =& . e
Compile and Download Objects". c”t c:’l*c
H A opy rl+
A dialog for compiling and Paste RTRY
downloading the project is opened.
Delete Drel
PLC 3 Download
Print N Compile and Download Objects...
55. | Check all check boxes and start the
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6 Startup of the application

6.4 Hardware configuration in STEP 7 V12

No. Instruction Remarks
56. | If blocks have not been transferred,
download the blocks manually. Open Object Ctrl+ Al O
To do this, select all blocks in the Cut Ctrl+X
block directory and select "PLC> Copy Cirl+C
Download" in the context menu. Paste Cirl+V
Delete Del
Insert New Object 5
PLC Download
6.4 Hardware configuration in STEP 7 V12

Configuration of the ET 200S
Table 6-7

57.

Start the TIA Portal V12 in the project view.
Search for "Nodes accessible online".

To this end, navigate to "Project Tree> Online
Access> [Your_Ethernet_Adapter]> Update
accessible devices".

Your ET 200SP station is now recognized.

~ 1z Online access
» (R USE [57USE]
# [ COM [RS232/FFI multi-master cable]
v [H COM <2 [RS232/FFI multi-master cable]
¥ [ PLCSIM VS x [PHIIE]
+ [ 7 Intel(R) PROI1 000 MT-Netzwerkverbindung
p¥IUpdate &

project:
IM151-3PN
Confirm the action with "Assign name".

The S7-300 station is now assigned the
PROFINET name of your engineering station.

58. Now navigate to "[Your_ET200SP_Station]> ~ [ im151-3pn [192.168.0.1 1
Online & dla.gnostlcs . . . . o (e ——
In the graphical area of "Online & diagnostics",
select "Functions> Assign name".
* Functions
Aszign IP address 2
'
Reset to factory settings
59. Enter the following device name used in the

1.

FROFIMET device name:

2.

l_ Assign name

im151-3pn|
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6 Startup of the application

Configuration of the SIMATIC S7-300 CPU

6.4 Hardware configuration in STEP 7 V12

Table 6-8
No. Instruction Remarks
60. Start the TIA Portal V12 in the project view. - % Online access

Search for "Nodes accessible online".

To this end, navigate to "Project Tree> Online

Access> [Your_Ethernet_Adapter]> Update
accessible devices".

Your SIMATIC S7 station is now recognized.

¥ [ USE [STUSE]

zﬂ COM [RS232/PPI multi-master cable]
('R COM <2> [RS232/PFl multi-master cable
[ PLCSIM VS x [PNIIE]

tﬂ Intel(R} PROM 000 MT-Metawverkverbindu

g Up

b
b
b
-

date accessible devices

61. Now navigate to "[Your_S7_Station]> Online ~ [ 57-300 [192.168.0.2]
& diagnostics". [
In the graphical area of "Online & b [ Program blocks
diagnostics", select "Functions> Assign IP » [3 Technology objects
address".
= Functions
Settime
Firmware update
Assign name
Reset of FROFINET interfac...
62. Enter the following IP address and subnet

mask in the input fields:

192.168.0.2.

255.255.255.0

Confirm the action with "Assign IP address".

The S7-300 station is now assigned the IP
address of your engineering station.

IPaddress: 192 . 168 . O .2
Subnet mask: 255 . 255 . 255 . O

[] Use router

Router address: 192 _ 168 . O .2

| Assign IP address
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6 Startup of the application

6.5

6.5 Retrieving and downloading the project in STEP 7 V12

Retrieving and downloading the project in STEP 7 V12

Retrieving the project

The following table states the procedure for retrieving the STEP 7 project.

Table 6-9
No. Instruction Remarks
63. Load the file "109474714_TIA_S7-
300_ModbusRTU_CODE_V10.zap12" to a
local directory on your PC.
64. Start the TIA Portal in the project view. Select T4 Siemens - PtP_CM_MV340_S7300
"Project > Retrieve".
Project [Edit Wiew Insert Online Option
If there is already a project opened, it is closed U New..
when the appearing prompt has been 7| (¥ open... Cerl+0
confirmed. Migrate praject...
Close Ctrl+wW
K save crrl+s
Save as.. Ctrl+Shift+S
Delete project... Ctrl+E
Archive...
S Card Reader/USE memory b
| Memory card file ]
65. Navigate to "109474714_TIA_S7-
300_ModbusRTU_CODE_V10.zap12" and
open the file.
66. Select any project storage location. w 7] PtF_Modbus
By clicking "OK" the project is retrieved and ";. P
opened. '
EEE, Devices & networks
» (1 PLC_1 [CPU 1516-3 PN/DF]
» [g§ Commaon data
b Eﬂ] Docurmentation settings
r r:@ Languages & resources
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6 Startup of the application

6.5 Retrieving and downloading the project in STEP 7 V12

Downloading the project to the CPU

The following table states the procedure for downloading the STEP 7 project to the

CPU.
Table 6-10
No. Instruction Remarks
67. Make sure that your engineering station is Internet Protocol Version 4 (TCP/IPva) Properties E

located in the same subnet as the S7-300
CPU.

Example:
IP address: 192.168.0.251
Subnet mask: 255.255.255.0

General

You can get IP settings assigned automatically if your network supy
this capability. Otherwise, you need to ask your network administr:
for the appropriate IP settings.

Obtain an IP address automatically
@ Use the following IP address:

configuration to your S7-1500 CPU via the
"Download to device" button.

After the download, a message appears,
informing that the download process has been
completed successfully.

IP address: 192 . 168 . 0 .251
Subnet mask: 255.255.255. O
Default gateway:
68. Compile the project via "S7-1500> Compile" or H Al
via the corresponding icon. m -u I E*!f
In the inspector window, a message appears,
informing that the compilation has been
completed successfully.
69. After error-free compilation, download the
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7 Operation of the application

7.1 Monitoring

7
7.1

Operation of the application

Monitoring

Overview

When having activated the sample project, your CPU cyclically processes the user

program.

In that, data with a length of 2 words from the slaves are read from the DBs

Data_Slave_1 and Data_Slave 2.
The data read by the master are stored in the array

"Master_Data".Master_comm][1].buffer or "Master_Data".Master_comm][2].buffer.
For a better monitoring of the actions of the user program, the variables table

Modbus_Overview is provided.

Variables table Modbus_Overview

Tabl

The following table indicates which information can be taken from the watch table.

The watch table can be adjusted to your own project.

e7-1

Variable

Remarks

Master_Modbus

..].stat_save_comm

If an error occurs, the value of the status is stored here.

..].done_count_gen

Counts the number of successful calls of instructions in the FB
Modbus_Master (FBS5).

..].err_count_gen

Counts the number of error messages of the instructions in the FB
Modbus_Master (FBS5).

[...].STATUS Output parameter STATUS.

[...].STATUS Stored parameter status of the 1st communication job.
[...].STATUS Stored parameter status of the 2nd communication job.
[...].INIT Input parameter INIT.

[...].number Indicates with which slave in the array of Master_Data

communication is currently (to be) effected.

Slaves

..].CP_START_OK

Initialization of slave1 successful

..].CP_START_ERROR

Initialization of slave1 not successful

[.

[.

[...].STATUS Slave1: status saved in the case of an error
[...].CP_START_OK Initialization of slave2 successful
[...].CP_START_ERROR | Initialization of slave2 not successful
[...].STATUS Slave2: status saved in the case of an error

Data

..].buffer[0]

First word of the buffer for communication with slave1

..].buffer[0]

First word of the buffer of slave1.

..].buffer[0]

First word of the buffer for communication with slave2.

—_——_——_—]—

..].buffer[0]

First word of the buffer of slave2.
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7 Operation of the application

7.2 Data reading from Modbus slave to Modbus master

7.2 Data reading from Modbus slave to Modbus master

This chapter describes how to transmit data from the slaves to the master.
The sample program reads data from the Modbus slaves to the Modbus master.

Table 7-2
No. Instruction Remarks
70. Activate the application as

described in Chapter 6.

71. Open the watch table
Modbus_Overview and select
the option "Monitor variable".

Al )4

You now see the actual values of the watch table.

When having activated the application successfully, the
variable "done_count_gen" is incremented consistently.

72. Enter any value for the slaves in
the "Modify value" column.

é"f-'lﬂster_DETE".P.'Iaster_cu mm[1].buffer[0] HEX WH16#0000
{"Data_slave_1"butfer(n] HEX WH16#0000 V1620005
g"f-'l aster_Data".Master_comm([2].buffer]0] HEX WH16#0000
§|'Data Slave 2 buffer(0] HEX wxw W#16%0001

In the figure, the values correspond to the station addresses

of the slaves.

73. By clicking on the "Modify
variable" button the values are
applied to the slaves.

fesle] &)
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74. By processing the Samp|e "Master_Data”.Master_comm[1].buffer[0] HEX V1640005 .‘-.‘
prOjeCt the master now reads "Data_Slave_1".buffer{0] HEX WH16#0005 ._J’ 160005
the entéred data from the slaves "Master_Data” Master_comm(2].buffer[0] HEX WEIB£0001 =,
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8 Related literature

8 Related literature

Internet links

The following list is not complete and only represents a selection of relevant

information.
Table 8-1
Subject Title
\1\ Reference to the entry http:/support.automation.siemens.com/WW/view/en/
109474714

\2\ Siemens Industry Online http:/support.automation.siemens.com
Support

\3\ SIMATIC S7-300/S7-400 http://support.automation.siemens.com/WW/vie
Loadable driver for point-to-point | w/en/1220184
CPs: MODBUS protocol, RTU
format, S7 is master

\4\ SIMATIC S7-300/S7-400 http://support.automation.siemens.com/WW/vie
Loadable driver for point-to-point | w/en/1218007
CPs: MODBUS protocol, RTU
format, S7 is slave

\5\ SIMATIC S7-300 Establishing http://support.automation.siemens.com/\WW/vie
and parameterizing point-to- w/en/1117397
point connection CP 341

\6\ SIMATIC ET 2008 distributed http://support.automation.siemens.com/WW/vie
I/0O Interface Module 151-3 PN w/en/30598131
(6ES7151-3AA23-0AB0)

\7\ SIMATIC ET 200S serial http://support.automation.siemens.com/WW/vie
interface modules w/en/9260793

\8\ S7-SCL V5.3 for S7-300/400 http://support.automation.siemens.com/WW/vie

w/en/5581793
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Table 9-1
Version Date Modifications
V1.0 04/2013 First version
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